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Get Help

Get Help
There are a number of ways to learn more about your product and interact with Oracle and other users.

Get Help in the Applications
Use help icons    to access help in the application. If you don't see any help icons on your page, click your user image
or name in the global header and select Show Help Icons.

Get Support
You can get support at My Oracle Support. For accessible support, visit Oracle Accessibility Learning and Support.

Get Training
Increase your knowledge of Oracle Cloud by taking courses at Oracle University.

Join Our Community
Use Cloud Customer Connect to get information from industry experts at Oracle and in the partner community. You
can join forums to connect with other customers, post questions, suggest ideas for product enhancements, and watch
events.

Learn About Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program. Videos included in
this guide are provided as a media alternative for text-based topics also available in this guide.

Share Your Feedback
We welcome your feedback about Oracle Applications user assistance. If you need clarification, find an error, or just
want to tell us what you found helpful, we'd like to hear from you.

You can email your feedback to oracle_fusion_applications_help_ww_grp@oracle.com.

Thanks for helping us improve our user assistance!

i

https://support.oracle.com/portal/
https://www.oracle.com/corporate/accessibility/learning-support.html#support-tab
https://www.oracle.com/education/
https://cloudcustomerconnect.oracle.com/pages/home
https://community.oracle.com/customerconnect/categories/idealab-guidelines
https://www.oracle.com/corporate/accessibility/
mailto:oracle_fusion_applications_help_ww_grp@oracle.com
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1  Introduction

Overview of Workforce Health and Safety  
Keep your employees safe and streamline the reporting of environmental health and safety (EHS) incidents with Oracle
Fusion Workforce Health and Safety Incidents.

Let's review what you can do in the application:

• Quickly enter incident details.

• Conduct reviews and automate follow up.

• Assign and remind incident owners of incident activities.

• Categorize incidents into different event types, such as vehicle incident or environmental spills or releases.

• Identify unsafe working conditions or unsafe acts.

• Check the progress of reported incidents using analytics.

• Use HCM Cloud Global HR data and processes.

• Secure data and functions by roles and privileges.

• Conduct health surveys for employees.

Here's how the feature can help you and your organization:

• Create a safer work environment.

• Reduce risk, disruption, and costs.

• Comply with environmental, health and safety regulations.

• Help organize the reporting of incidents.

• Identify and correct shortcomings in the health and safety management programs.

Here's what different users can do in the application:

• For employees, a simple user interface makes it easy to report an incident or complete a health survey.

• For health and safety managers, a richer interface provides everything you need to report, manage, and resolve
incidents.

1
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Related Topics
• Safety Incident Roles

• Create a Health and Safety Incident Report

• Manage Safety Incidents

• Create Reports and Analytics

Safety Incident Roles  
You need the Environmental Health and Safety (EHS) Manager role to use the product features and to create new roles
and assign them privileges.

As EHS Manager, you can grant these roles and privileges to other users.
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Privilege Name Description

Create Environment Health and Safety
Incident
 

Create an incident.
 

Review Environment Health and Safety
Incident

Update an incident and related aspects.

Create Environment Health and Safety
Incident Action
 

Create an incident action.
 

Create Environment Health and Safety
Incident Event
 

Create an incident event.
 

Create Environment Health and Safety
Incident Investigation
 

Create an incident investigation.
 

Create Self-Serve Environment Health and
Safety Incident
 

Create a self-service incident.
 

Delete Environment Health and Safety
Incident
 

Delete an incident.
 

Delete Environment Health and Safety
Incident Action
 

Delete an incident action.
 

Delete Environment Health and Safety
Incident Event
 

Delete an incident event.
 

Delete Environment Health and Safety
Incident Investigation
 

Delete an incident investigation.
 

Manage Environment Health and Safety
Configuration Settings
 

Update configuration settings.
 

Update Environment Health and Safety
Incident
 

Update an incident.
 

Update Environment Health and Safety
Incident Action
 

Update an incident action.
 

Update Environment Health and Safety
Incident Event
 

Update an incident event.
 

Update Environment Health and Safety
Incident Investigation
 

Update an incident investigation.
 

View Environment Health and Safety
Incident
 

View an incident.
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Privilege Name Description

View Environment Health and Safety
Incident Action
 

View an incident action.
 

View Environment Health and Safety
Incident Event
 

View an incident event.
 

View Environment Health and Safety
Incident Investigation
 

View an incident investigation.
 

Access Assignment Rules Management
Page

Access the Assignment Rules page.

Create Health and Safety Assignment
Rules

Create assignment rules for health and safety incidents.

Edit Health and Safety Assignment Rules Update assignment rules for health and safety incidents.

Delete Health and Safety Assignment
Rules

Delete assignment rules for health and safety incidents.

Access Health and Safety Assignment
Rules

Access assignment rules for health and safety incidents.

Edit Health and Safety Assignment Rules
Processing Order

Edit processing order of assignment rules for health and safety incidents.

View Health and Safety Assignment Rules View assignment rules for health and safety incidents.

Note:  Users need to have the HRQ_REST_SERVICE_ACCESS_QUESTIONNAIRES_PRIV privilege to create a health
survey incident using the employee self-service page.

4
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2  Set Up Workforce Health and Safety
Incidents

Overview of Implementing Workforce Health and Safety
Incidents  
You must have the Application Implementation Consultant role
(ORA_ASM_APPLICATION_IMPLEMENTATION_CONSULTANT_JOB) to implement the application. Set up the tasks
associated with Workforce Health and Safety Incidents by using Functional Setup Manager. Refer to the Oracle
Applications Cloud Using Functional Setup Manager guide for more information.

Use this application to report and manage work-related incidents and hazards, capture critical event information, and
manage risk in the workplace. The functional area is the Workforce Health and Safety Incidents, which sits within the
Workforce deployment offering. Use the Associated Features report to see a full list of functional areas and features.
You get this report at the time of planning the implementation.

Related Topics
• Plan Your Implementation

Implement Workforce Health and Safety Incidents  
You need to complete various setup tasks as a part of the implementation.

Setup Tasks
• Assign the Environmental Health and Safety Manager role to the relevant user

• Configure target completion dates for an incident

• Configure lookup values in Workforce Health and Safety

• Configure profile options in Workforce Health and Safety

• Manage questionnaires for incident investigation

• Configure email alerts incident events

You use the Define Environment, Health, and Safety Setup task in the Setup and Maintenance work area. If you're
already using Oracle Fusion Global Human Resources (which is required for Workforce Health and Safety Incidents),
then you're almost there.

5
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Assign Environmental Health and Safety Manager Role
The implementor must assign the EHS manager role to the user.

1. Open the Security Console by clicking Navigator > Tools > Security Console.
2. In the User Accounts tab, search the user that you want to assign the role.
3. Click the role to open the role details.
4. Click Edit and then Add Role.
5. In the Add Role Membership window, search Environment, Health and Safety Manager.
6. Select the role and click Add Role Membership.
7. Click Done and then Save and Close.

Optionally, you can designate one or more people as safety coordinators for incidents. A person who is assigned the
safety coordinator role has full access to all incident aspects including the event, investigation, and actions. To act as a
safety coordinator, the person must have the HNS_REVIEW_ENVIRONMENT_HEALTH_AND_SAFETY_INCIDENT_PRIV
privilege assigned to them. There's no limit on the number of safety coordinators that can be assigned to an incident.

Configuring Target Completion Dates
In an incident report, the target completion dates, target review dates, target approval dates, and target preapproval
dates are already set to sixty days from the date of the incident creation. The EHS Manager can update these values.

1. In the Setup and Maintenance work area go to:

◦ Offering: Workforce Deployment

◦ Functional Area: Workforce Health and Safety Incidents

◦ Task: Manage Environment, Health and Safety Completion Dates

2. On the Manage Environment, Health and Safety Completion Dates page, edit the target dates as required.

Configuring Lookup Types
You can modify extensible lookups and lookups that have the configuration level set to Useror Extensible.

1. In the Setup and Maintenance work area, go to:

◦ Offering: Workforce Deployment

◦ Functional Area: Workforce Health and Safety Incidents

◦ Task: Manage Environment, Health and Safety Configuration Settings

2. On the Manage Environment, Health and Safety Configuration Settings page, search for the ORA_HNS lookup
types. The default lookup types and their descriptions are available.

3. Update the lookup types as necessary.

You can enable and disable events on the Safety Incidents > Report an Incident page using the corresponding lookup
values. You can enable and disable events separately for employees and professional users. You can order the events
so that they appear in a set order on the Safety Incidents page for employees and the events list page for professional
users. Here’s how you do it:

1. In the Setup and Maintenance work area, select Tasks in the right pane. Search for and select the Manage
Environment, Health and Safety Incident Events task.

2. On the Manage Incident Events Lookup page, you can see all events listed as lookup values. Select the events
you want to enable for employees and professional users.

6
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3. In the Order column, specify the order in which the events should appear for employees and professional users.
Note that the Health Survey option is always on top. Safety and cybersecurity events are separately ordered.

Employees and professional users will be able to see only those events you enable when they access the Report an
Incident page.

Configuring Profile Options
You can use these profile options to control how the application operates. To change any profile option value, search
for and select the Manage Administrator Profile Values task. In the Application field, select Workforce Health and Safety
Incidents and search for the relevant profile option.

Profile Option Name Description Profile Value

ORA_HNS_ALLOW_ACCESS_BY_INCIDENT_
REPORTER_AND_LOGGEDIN_USER
 

Enables the incident reporter and the logged in
user to access incidents they reported.
 

Y
 

Note:
The profile value is set to N by default.
 

HNS_KIOSK_SHOW_EVENTS Enables employees to view the Report an
Incident page where they can select the type of
event and report an incident.

Y

Note:  The profile value is set to Y by default.

HNS_EXPERT_RESPONSIVE_ENABLED Enables the mobile-responsive of Environment,
Health and Safety Incidents Professional pages.

Y

Note:  The profile value is set to N by default.

HNS_KIOSK_RESPONSIVE_ENABLED Enables the mobile-responsive of Environment,
Health and Safety Incidents Self-Service pages.

Y

Note:  The profile value is set to N by default.

Configure Email Alerts
You can use the Alerts Composer to send emails or notifications triggered by an event.

The following table describes the alerts you can use with Workforce Health and Safety Incidents:

Alert Name Description

HNS_Worker_Notification_Appointed
 

Sends an email when an employee is assigned any of these roles:
 

• Incident Owner, Reviewer, or Approver

• Incident Event Owner

• Incident Investigation Owner, Reviewer, or Approver

• Incident Action Owner, Reviewer, or Approver

HNS_Worker_Notification_Removed
 

Sends an email when an employee is removed from any of these roles:
 

7
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Alert Name Description

• Incident Owner, Reviewer, or Approver

• Incident Event Owner

• Incident Investigation Owner, Reviewer, or Approver

• Incident Action Owner, Reviewer, or Approver

HNS_Worker_Notification_Report_Incident
 

Sends an email to thank an employee for reporting the incident.
 

To turn the email alerts on:

1. Click > Navigator > Tools > Alerts Composer.
2. Search the required Workforce Health and Safety Incidents alert name.
3. Click the alert name to open the Edit Event Alert page.
4. Click the Run Options tab.
5. Select the Simulate Run value as No.
6. Click Save and Close.

Manage Questionnaires
The incident investigations use questionnaires to assist investigators during their investigation. It helps the organization
ensure consistency and quality of the investigations. Questionnaires also provide flexibility and fit as the investigator
can select from a list of questionnaires defined and configured by your administrator.

Workforce Health and Safety is a subscriber of Questionnaires. Cybersecurity is another subscriber. As an administrator,
you can define and manage your set of questions, questionnaires, questionnaire templates in the Setup and
Maintenance work area Workforce Development offering. You can search for these tasks and use them to define and
manage your questionnaires.

1. Questionnaire Lookups
2. Questionnaire Templates
3. Questionnaires
4. Question Library

To start with, you can find a questionnaire template, Workforce Health and Safety Standard Investigation under the
Workforce Health and Safety subscriber. You can make use of it and create your questionnaire.

1. In the Setup and Maintenance work area, go to:

◦ Offering: Workforce Development

◦ Task: Questionnaires

2. In the Questionnaires page, search for Workforce Health and Safety subscriber. You can see a Questionnaire
Library folder and a Health Surveys subfolder. Use the former to create questionnaires related to safety
incidents investigation and latter to create health survey questionnaires. Create the questions within the
questionnaire also in the relevant folder. You can also search for and select the Cybersecurity subscriber to
manage questionnaires in this area.

3. Click Create.
4. You need to select a questionnaire template to create a questionnaire. Search for and select Workforce Health

and Safety Standard Investigation questionnaire template. This Health and Safety template is provided for
you to start with. You administrator can create more templates that are specific to your organization.

5. Modify the Basic Information and Contents of the questionnaire as per your needs.

8
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6. Review the questionnaire and click Save and Close.

Related Topics
• How can I edit lookups?

• Questionnaires

• How You Create Questions

How You Create a Questionnaire  
This topic explains how to create a questionnaire by selecting a questionnaire template and specifying relevant
information in the questionnaire. It also lists the points to consider while editing a questionnaire.

Select the Questionnaire Template
In the Setup and Maintenance work area, select these options:

• Setup: Workforce Development

• Functional Area: Questionnaires

• Task: Questionnaires

If you use Performance Management, you can also go to My Client Groups > Performance > Questionnaires.

1. In the Folders section of the Questionnaires page, select the subscriber application for the questionnaire, for
example Performance 360, Recruiting, or Learning Assessments.

2. In the Search Results section, click Create.
3. Enter Questionnaire Template ID or Name values, if available. Alternatively, click Search to list all available

templates.
4. In the Search Results section, select a template and click OK.

Enter Questionnaire Basic Information
1. A unique numeric questionnaire ID appears automatically. You can change this value.
2. If this is a scored questionnaire, an overall score calculation rule appears. You can select a different rule.
3. Enter a Name and select a Folder. Use folders to organize questionnaires by type or purpose.
4. Leave the Owner field blank and the Privacy value set to Public if anyone who can access the questionnaire

can edit it. Otherwise, select an owner and set Privacy to Private.
5. Leave the Status value set to Draft until the questionnaire is ready.
6. For the Touchpoints and Journey Surveys subscribers, select a pagination option from the Display Format list.

Note:  When you display one section per page, section instructions, if any, appear below the section title.
When you display all questions on a single page, questionnaire instructions and section instructions appear
below the respective titles.

7. In the Instructions and Help Materials section, enter and format any instructions for questionnaire users. This
text appears at the top of page one of the questionnaire.

8. Add file or URL attachments, if appropriate. Links appear at the top of the questionnaire and beneath any
instruction text.

9. Click Next.

9
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Enter Questionnaire Contents
The Section Order and Section Presentation values are as specified in the questionnaire template, for example,
Sequential as the Section Order and Stack Regions as the Section Presentation. Depending on template settings,
you may be able to change these values. Depending on template settings, you can edit some or all section settings. You
can also delete predefined sections and create additional sections.

1. Select the first section to view its questions in the Questions section. You can delete a question or change its
response type and Required setting.

2. If you create additional sections, you add questions to them. In the Questions section, click Add. Search for
a question, select it, and click OK. The question is added below the question that appears highlighted in the
Questions section. You can reorder the questions by dragging them by the expandable arrow that appears in
the first column and dropping them in another row.

Note:  You can view the version number of the question in the Search Results section. If this column doesn't
appear, click the View menu and select Columns > Question Version Number.

3. You can also create questions for a section. Select a section, and in the Questions section, click Create.
4. Select the Folder, and enter question and response details, and click Save and Close. The question becomes

available in the question library as well. Add the question to the section using the instruction in step 2.
5. Edit questions as required. Select a question and click Edit. Enter question and response details, and click Save

and Close. The question is updated in the questionnaire and the question library.

Note:  Although you can override the response types for questions while defining a questionnaire, you can't
change the response type to text for questions that accept date responses or change the response type to
date for questions that accept text responses.

6. When all sections and questions are complete, click Next.
7. Click Preview to preview the questionnaire. For scored questionnaires, click Test to verify the scoring.

Note:

◦ When you click Reset after testing, the previously filled responses are retained in the
questionnaire. This allows you to modify specific responses as per your needs and test the
behaviour of the questionnaire again.

◦ The questions in a section are displayed in the order specified in the Section Order field.

◦ Questionnaire surveys that are created for both Touchpoints and Journey Surveys subscribers
are distributed to respondents using the Journeys application. So, when you preview the
questionnaire survey in ADF-based pages, the response options appear in a drop-down list.
However, when you view the survey in the Journeys application, you can see the horizontal
button responses and the question display format that you’ve chosen.

8. Click OK and then click Save.

Note:  If a questionnaire isn't in use, you can still add new questions that accept date response types, or create a new
version of the questionnaire to add such questions. When you edit the response type for a question in a questionnaire
that isn't in use, the updated response type is reflected in the questionnaire definition.

10
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Editing a Questionnaire
To edit a questionnaire, go to the Questionnaires setup page, and select a questionnaire from the Search Results
section and click Edit.

A few points about editing a questionnaire:

Set the questionnaire Status value to Active when the questionnaire is ready for use.

If a questionnaire isn't in use, you can still add new questions that accept date response types, or create a new version
of the questionnaire to add such questions. When you edit the response type for a question in a questionnaire that isn't
in use, the updated response type is reflected in the questionnaire definition.

You no longer need to go into the edit mode to preview a questionnaire. You can preview it from the Search Results
section of the Questionnaires setup page. You can preview draft, active, and inactive questionnaires.

Related Topics
• What happens if I edit a questionnaire that's in use?

Descriptive Flexfields for Health and Safety  
You can add descriptive flexfields for your organization and define validation and display properties for health and
safety entities.

Define Descriptive Flexfields Segments
Use the Manage Descriptive Flexfields task in the Setup and Maintenance work area to define a segment for a
descriptive flexfield for the Workforce Health and Safety Incidents module. You can add descriptive flexfields for
these entities:

• Incidents details

• Events

• Investigations

• Actions

• Risk assessments

This table describes the descriptive flexfields available by default in Health and Safety.

DFF Name DFF Code Description

Descriptive Flexfields for Incidents
 

HNS_INCIDENTS_DFF
 

Fields for incident information on the Report
an Incident page for professional user and
employee.
 

DFF for Air Quality Events
 

HNS_AIR_QUALITY_EVENTS_DFF
 

Fields for air quality information on the Air
Quality Event Details page of the incident.
 

11
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DFF Name DFF Code Description

DFF for Driver and Vehicle Incident Events
 

HNS_DRIVER_AND_VEHICLE_EVENTS_DFF
 

Fields for driver and vehicle information on the
driver and Vehicle Incident Event Detail page of
the incident.
 

DFF for Ergonomic Events
 

HNS_ERGONOMIC_EVENTS_DFF
 

Fields for ergonomic information on the
Ergonomic Event Details page of the incident.
 

DFF for Fire or Explosion Events
 

HNS_FIRE_OR_EXPLOSION_EVENTS_DFF
 

Fields for fire or explosion information on the
Fire or Explosion Event Details page of the
incident.
 

DFF for Injured Person Summary Events
 

HNS_INJURED_OR_ILL_PERSON_EVENTS_DFF
 

Fields for injured or ill person information on
the Illness or Injury Event Details page of the
incident.
 

DFF for Issue Events
 

HNS_INJURED_PERSON_SUMMARY_EVENTS_
DFF
 

Fields for injured or ill person information on
the Illness or Injury Event Summary page.
 

DFF for Injured or Ill Person Events
 

HNS_ISSUE_EVENTS_DFF
 

Fields for issue information on the Issue Event
Details page of the incident.
 

DFF for Near Miss Events
 

HNS_NEAR_MISS_EVENTS_DFF
 

Fields for near miss information on the Near
Miss Event page.
 

DFF for Notice of Violation Events
 

HNS_NOTICE_OF_VIOLATION_EVENTS_DFF
 

Fields for notice of violation information on the
Notice of Violation Event page.
 

DFF for Property Damage Events
 

HNS_PROPERTY_DAMAGE_EVENTS_DFF
 

Fields for property damage information on the
Property Damage Event page.
 

DFF for Spill or Release Events
 

HNS_SPILL_OR_RELEASE_EVENTS_DFF
 

Fields for spill or release information on the
Spill or Release Event page.
 

DFF for Suggestion for Improvement Events
 

HNS_SUGG_FOR_IMPROV_EVENTS_DFF
 

Fields for suggestion for improvement
information on the suggestion for the
Improvement Event page.
 

DFF for Unsafe Act Events
 

HNS_UNSAFE_ACT_EVENTS_DFF
 

Fields for unsafe act information on the Unsafe
Act Event page.
 

DFF for Unsafe Condition Events
 

HNS_UNSAFE_CONDITION_EVENTS_DFF
 

Fields for unsafe condition information on the
Unsafe Condition Event page.
 

DFF for Vehicle Events
 

HNS_VEHICLE_INCIDENT_EVENTS_DFF
 

Fields for vehicle incident summary information
on the Vehicle Incident Event Summary page.
 

Descriptive Flexfields for Investigations
 

HNS_INVESTIGATIONS_DFF
 

Fields for investigation information on the
Investigation Details page of the incident.

12
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DFF Name DFF Code Description

 

Descriptive Flexfields for Actions
 

HNS_ACTIONS_DFF
 

Fields to track action information on the Action
Details page of an incident.
 

Descriptive Flexfields for Risk Assessments HNS_RISK_ASSESSMENTS_DFF Fields to track risk assessment of an incident
in the Risk Assessment section on the Safety
Incident page.

These are the descriptive flexfields for Security Incidents:

DFF Name DFF Code Description

DFF for Lost or Stolen Device Events
 

HNS_LOST_OR_STOLEN_DEVICES_DFF
 

Fields for lost or stolen device information on
the Lost or Stolen Device Event page.
 

DFF for Other CyberSecurity Issue Events
 

HNS_OTHER_DATA_SECURITY_ISSUES_DFF
 

Fields for other cybersecurity issue information
on the Other Cybersecurity Issue Event page.
 

DFF for Suspicious Email or Call Events
 

HNS_SUSPICIOUS_EMAIL_OR_CALLS_DFF
 

Fields for suspicious email or call information
on the Suspicious Email or Call Event page.
 

DFF for Unauthorized System Access Events
 

HNS_UNAUTHD_SYSTEM_ACCESSES_DFF
 

Fields for unauthorized application access
information on the Unauthorized System
Access Event page.
 

Deploy Descriptive Flexfields
Remember to deploy the changed or configured flexfield to ensure that the latest definition is available to users.

Note:  The DFF that is available in the professional user page appears in the employee self-service too. The DFF
attributes are located before the Lessons Learned  field of the Incident page.

Related Topics
• Overview of Descriptive Flexfields

• Considerations for Planning Descriptive Flexfields

• Considerations for Managing Descriptive Flexfields

• Overview of Flexfield Deployment
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3  Create Safety Incidents

Create a Health and Safety Incident Report  
Employees can report an incident in Workforce Health and Safety by navigating from Home>Me>Safety Incidents. If you
can't find the Safety Incidents app, contact your EHS Manager to make the app available for you.

1. Click Safety Incidents to open the Report an Incident page. Various event tiles appear in a page. You may
want to select one or more event types when reporting the incident.

2. Select one or more Event Type check boxes, for example, Ergonomic, Air Quality, and so on. After submitting
the incident, the application creates the relevant events for the incident.

Note:  This event tiles page is displayed based on the Employee Self-Service Events
(HNS_KIOSK_SHOW_EVENTS) profile option and Manage Incident Events Lookup page settings. By default,
the option is enabled. If your administrator has decided not to show the events page, then you won't see
the event tiles page in employee self-service. You can also see the Health Survey option on the page if your
administrator has enabled it. Select this option only if you want to take a health survey.

3. Click Continue.
4. On the Report an Incident page, Incident Details region, specify details in What's the incident? incident

Description, and Actions already taken.
5. Select Level of Security. Specify where the incident occurred and other details.
6. Click Continue.

Note:  The Incident Details, Who's reporting this Incident?, Attachments regions open sequentially.

7. In the Who's reporting This Incident? region, your details appear for Incident Reporter type, reporter name.
You can change the details if the default values aren't correct.

8. Select the name of the person in the Who was notified? field.
9. Select the notified person name, notifications date and time in the Who was notified? and Notification Time

fields.

Note:  For events of type Virus, Illness or Injury, you can enable the Notified Human Resources check box
and specify a date and time for notifying HR. This causes a notification to be sent to the Human Resources
(HR) representative of the injured person. The HR representative is identified based on areas of responsibility.
Human Resource (HR) Specialists assign responsibilities to workers (such as HR Representative, Benefits
Representative) using the Manage Areas of Responsibility task. If the injured person doesn’t already have a
HR representative, they must be assigned one using this task.

10. Click Continue to go to the Attachments region.

Tip:  Click the Edit icon to go back to any region and modify the details, if required.

11. Add any relevant attachments for the incident.
12. Click Submit.

Your incident is now on its way to the EHS Manager for resolution.
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Related Topics
• How You Assign Areas of Responsibility

Complete a Health Survey  
In this example, you take a health survey to provide information about your current state of health. The health survey is
created and made available to you by your administrator.

Note:  There are no predefined health surveys in the application, the administrator needs to set them up.

1. Click Safety Incidents to open the Report an Incident page.
2. Select Health Survey and click Continue.
3. On the Health Survey Details page, complete the fields as shown in this table.

Field Value

What type of survey responder are you?
 

Employee
 

Survey Responder Name
 

Pat Williams
 

Survey Date and Time
 

3/1/21 2:30 PM
 

Survey Location
 

California
 

4. A questionnaire is shown based on the survey details you entered. Enter your responses to the questions and
click Submit. Note that you have to enter responses for all the required questions.
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4  Manage Safety Incidents

Professional User's Incidents Work Area  
As a professional user, you can manage the incidents in the Incidents work area by navigating to Home My Client
Groups Safety Incidents . You can search for incidents, modify, and report incidents.

You can search for incidents by:

• Incident name or number

• Filters such as:

◦ Target completion date

◦ Level of severity

◦ Event type

◦ Location

◦ Status

◦ When incident was reported

• Saved Searches: Use the available saved searches or personalize your search by saving your search for yourself
or others. Click the gear wheel to select the search criteria.

Find the list of incidents on the page sorted by default in this order:

• Incidents with no owner; sort by earliest target completion first

• Earliest target completion date of the incident

• Incident with an owner; sorted by earliest completion date first

Use the Sort By list to order the incidents list by these options:

• Incident Number (from highest to lowest)

• Incident Reported Date (from newest to oldest)

• Target Completion Date of Incident (from oldest to newest)

• Severity Levels of Incident, (from highest to lowest)

• Relevance (default sorting pattern that's mentioned earlier)

Each incident in the list appears with key information such as incident name, number, date and time the incident took
place, notification time, name of the incident owner, target completion date, and completion status.

See the number of events, investigations, and actions that display for the incident. You can review and update the
details directly in the page. Additionally, you can use the incident name link to open the incident page and then go to
the specific details of the incident. Apart from searching for incidents, you can create incidents and manage them too.
Only the EHS manager can review, modify, and delete incidents.

Note:  Your access to incidents is based on the security privileges and active assignments in the incident.
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How Incident Records are Secured  
The application secures incident records using the standard data security framework.

A user can access an incident record only when both these conditions are met:

• The user has the requisite environment health and safety privileges.

• The user has access to the specific incident record.

Access to Incidents
The EHS manager assigns a user as the incident owner for any incidents created by employees in employee self-service.
When a professional user creates an incident, they can assign users to the incident by virtue of being the logged-in user.
Users receive emails when assigned to or removed from an assignment on an incident. This security approach ensures
that a user with an employee custom role having the relevant HNS privileges only can access incidents assigned to the
user.

Action Management
An action owner, preapprover, approver, or reviewer can’t access the incident details, event, or investigation pages. They
can only access the action record they are assigned to, if they have the requisite privilege.

Manage Safety Incidents  
When employees report incidents, they're accessible to the EHS Manager for resolution.

The EHS Manager assigns an incident owner for an incident, who manages and solves the incident. If you're using the
Journeys application, you can report a safety incident from within a journey.

In managing the incident, the incident owner captures additional details in the Incident Details, Events, Investigations,
Actions, and Attachments for the incident. Let's see the various aspects of an incident and how you can use them and
track the details. The Incident page has these tabs in the left pane. Click these tabs to open the respective pages.

• Details tab: The Incident page with the incident number as the page header starts with Incident Details
region followed by Location, Risk Assessment, Agencies Notified, Related Incidents, Notes, Stakeholders,
Incident Reviewers, Incident Approvers, and Incident Owner regions.

• Events tab: The Events page includes incidents if any events are already added. You may want to add any
relevant events to the incident. Click the Add button on the Events page and select the event type to create an
event. You can have only one event for an event type.

• Investigations tab: The Investigation page starts with Investigation Details region followed by the
Investigation Questionnaire, Findings, Overall Findings, Notes, Stakeholders, Investigation Preapprovers,
Investigation Reviewers, Investigation Approvers, and Investigation Owners regions.

• Actions tab: The Actions page starts with the Action Details region followed by the Notes, Stakeholders,
Action Preapprovers, Action Reviewers, Action Approvers, and Action Owners regions.
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• Attachments tab: You can add attachments and links relevant to the incident on the Attachments page.

Note:  For events of type Health Survey, you can see an additional section named Questions. You can see the
questionnaire that the employee has completed as a part of taking the health survey. The questionnaire is displayed
in read-only mode.

Integration with Journeys
As a Human Resources (HR) Specialist, these are the two ways in which you can configure safety incidents within
journeys:

• You can include a safety incident related task in the journey (by selecting the task type as Application Task and
the value as Safety Incident). For example, you can create a Safe Travels journey and include a safety incident
related task Report a safety concern. An employee who's assigned the Safe Travels journey can report a safety
incident from within the journey itself. The task includes a button Go to application task which takes the user
directly to the incident creation page.

• You can trigger a journey automatically when a safety incident is created with a specific event type. For
example, when an employee reports an incident of the type virus, injury or illness, you may want to assign a
journey to the incident reporter to complete these tasks: Create Absence, Inform Payroll, Submit Insurance
Claim. You can do this by configuring a Health and Safety- Incident event in the journey and selecting the
specific event type Virus, Illness and Injury. Note that you need to set the initiator as the performer for all the
tasks. The journey won't be triggered if the initiator is a nonemployee.

Risk Assessment of Safety Incidents  
You can do a risk assessment of an incident by accessing the incident from Home > My Client Groups > Safety Incidents.

Risk Assessment Parameters
You can add a risk assessment for an incident and select what's the consequence of the incident and what's the
likelihood of the incident happening. The consequence indicates what impact the incident has on the organization,
for example, insignificant, moderate, or catastrophic. The likelihood indicates what's the possibility of the incident
occurring, for example, remote, frequent, or repeated. Based on the consequence and the likelihood values you select,
the risk score is automatically calculated and displayed along with a description of what the score means. You can enter
a date for the risk assessment and also add multiple risk assessments as of different dates.

Risk Assessment Setup
You can change the values displayed in the Consequence and Likelihood fields, and also change the risk score
calculation. You can update the consequence, likelihood, and risk score values and their descriptions using the
Manage Environment, Health, and Safety Risk Assessment task in the Setup and Maintenance work area. In the
Consequence and Likelihood sections, you can change the existing name, value, and description. The risk score is
calculated by multiplying the consequence and likelihood values. You can change the risk score range and the name and
description for risk scores falling in that range.
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Enter Incident Details  
The incident Details page lets you record details about your incident, location, notified agencies, related incidents,
notes, stakeholders, incident reviewers, approvers, and owner. The incident owner is responsible for acknowledging the
completion of an incident report.

1. In the Incident Details region, specify the information for these attributes:

a. Summary and Description of the incident
b. Date and Time
c. Level of Security
d. Immediate Actions
e. Lessons Learned
f. Incident Reporter person type and name

g. Person who was notified and the notified time
2. Click Save and Close.
3. In the Incident Location region, update the location details, if required. Select the Conditions check boxes and

specify the related details.
4. Click Save.
5. In the Risk Assessment region, add a risk assessment and select the consequence and likelihood values. Note

that the risk score is automatically calculated and displayed.
6. If you know the agencies that were notified of the incident, select them in the Agencies region.
7. In the Related Incidents region, click Add to include the related incidents.

a. After the Incidents work area opens, search for and select the related incidents for reference, if you have
a role in that related incident.

b. Click Save and Close. The selected incidents appear in the Related Incidents region of this incident.
8. Track notes for the incident in the Notes region. Click Add.

a. Enter note text for the event.
b. Click Save. The note is saved and is displayed in the Notes region with name of the person who created

the note and the date when it was created.
9. Assign incident stakeholders, reviewers, and approvers in the respective region of the incident page and specify

related details.
10. Assign an incident owner and update the target completion date. When the incident is complete, you can

update the status and mark it complete.

Event Types for Incidents  
You have a number of event types based on which you can add events to your incident.
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You specify the Event Details, Notes, Stakeholders, and Event Owner details in the respective regions of the Event page.
This apart, you can specify event-specific attributes. Let's see the event-specific attributes and regions that can be
tracked for an event.

Event Type Event-Specific Regions and Attributes Description

Improvement Type
 

Event Details region>Improvement Type:
 
Communication
 
Environmental
 
Mechanical
 

Select a value from the Improvement Type list.
 

Air Quality
 

Event Details region>Air Quality Type:
 

• Values: Fumes, Mold, Odor, Smoke, Other

• Employee Name

Select a value from the Air Quality Type list.
 
Select the employee who was directly impacted
by the air quality.
 

Ergonomic
 

Event Details region > Ergonomic Type
 

• Ambient Temperature

• Contact Stress

• Posture

• Repetitive Task

• Use of Excessive Force

• Vibration

Request an ergonomic assessment check box
 
Employee Name
 

Select a value from the Ergonomic Type list.
 
Select the request for an ergonomic
assessment to ensure employee's correct
posture and reduce the exposure to physical
hazards.
 
Select the name of the employee.
 

Fire or Explosion
 

Select the one or more relevant check box
options:
 

• Fire

• Explosion

• Replenish Fire Fighting Equipment

Based on the option you select, specify the
relevant details for the attributes in the regions.
 

Virus, Illness, or Injury
 

Event details include Notified Human
Resources check box
 

When you select the option, specify the date
and time of notifying HR. This indicates that the
HR department is notified about the incident.
 

Virus, Illness, or Injury
 

Injured or Ill Person Details region attributes:
 

• Person Type

• Name

• Event date and time

• Name of the person who was informed
including the date and time

• Person activity before the incident

Specify the Person Type and Name of the
injured or ill person. Describe the activity of the
injured or ill person before the incident.
 
If the person has lost time, provide an estimate
of lost hours. If the person is absent from work
for 1 or more days, mention the details.
 
If the person returns to work, specify the Return
to Work attributes such as date, job transfer
or restrictions, if any. You can add information
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Event Type Event-Specific Regions and Attributes Description

• Source

• Mechanism

• Classification

• Injured Body Part and Injury Type

• Treatments

• Lost Time and Return to Work

for multiple treatments and multiple returns to
work.
 
A unique case number is generated for the ill or
injured person which is used to track details for
the Illness or Injury event.
 

Virus, Illness, or Injury
 

Witness Details region attributes:
 
Person Type
 
Name
 
Phone
 
Email
 

You can add one or more witnesses to the event
and specify the related details in the region.
 

Issue
 

Issue Event Details region> Issue Type:
 
External Non-conformance
 
Internal Non-conformance
 
Incident event
 
Investigation
 
Permit violation
 
Other
 

Select a value from the Issue Type list.
 

Unsafe Act
 

Event Details region> Unsafe Act Type
 

Select a value from the Unsafe Act Type list. For
example Incorrect Use of Personal Protective
Equipment, Job Safety Analysis Not Followed
 

Near Miss
 

 
Person
 
Property
 
Vehicle
 
Other
 

Select a value from the Near Miss list.
 

Property Damage
 

Event Details region> Property Damage Type
 
Public
 
Private
 
Company
 
Employee
 
Contractor
 

Specify a value from the Property Damage
Type list.
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Event Type Event-Specific Regions and Attributes Description

Customer
 
Supplier
 
Other
 

Unsafe Condition
 

Event Details region> Unsafe Condition Type
 
Biological Hazards
 
Physical Hazards
 
Security Hazards
 
Equipment or Machinery Hazards
 
Ergonomic Hazards
 
Chemical or Dust Hazards
 
Other Unsafe Conditions
 

Specify a value from the Unsafe Condition
Type list.
 

Spill or Release
 

Attributes
 
Spill or Release Type
 
Total Mass or Volume Released and Recovered
 
Possible Cause
 
What was Spilled or Released
 
Spill Kit Deployed
 
Cleanup Team or Contractor Notified
 
Does Spill Kit Need Replenishing?
 

Specify the values for these attributes and other
related attributes for the Spill or Release event.
 

Notice of Violation
 

Event Details region> Violation Type
 

Specify the value in the Notice of Violation type
for the event. For example, EPA, OSHA, Police,
 and so on
 

Vehicle Incident
 

Attributes:
 
Road Condition
 
Light Conditions
 
Weather Condition
 
Traffic
 
Traffic Controls
 
Police Report check box
 
Police Agency Location
 
Rental vehicle

Specify the values for these attributes and other
related attributes for the vehicle incident event.
Specify vehicle insurance details and details of
rental vehicles involved in the accident or rental
vehicles used as replacement.
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Event Type Event-Specific Regions and Attributes Description

 
Rental vehicle replacement
 
Insurance information
 

Create Incident Events  
You can record information about the events associated with the incident. You can create multiple incident events at the
time of reporting or managing the incident.

1. From the Events page of the incident, click Add to create an event.

Note:  Your administrator may want to show or hide or modify the event names by defining them in the
Manage Incident Events Lookup page. Based on those settings you can find the event types.

2. Click the event type. The respective event details page for the event type opens.
3. In the Incident Details region, enter the Summary, Description, Date and Time of the event, Reported Data and

Time, Level of Security, and Lessons Learned.
4. Click Save. The event is created and appears on the Events page of the incident.
5. You can track notes for the event in the Notes region. Click Add.

a. Specify note for the event.
b. Click Save. The note is saved and is displayed in the Notes region with the name of the person who

created the note and the date it was created.
6. In the Event Owners region assign a person to own the event and set the target completion date.

Note:  When the event is complete, you can close the event by selecting the Completed check box and
specifying the completion date.

7. If any action is required from the event owner, select the Action Required check box.
8. Click Save. The event is created with a unique event number and displayed in the list of events for the incident.

The application generates a unique identifier for the event and is displayed in the list under the Events page. All the
events that are created for the incident are listed here in this page.

Create Investigations  
Create and manage investigations to determine the root cause of incidents. The investigator can gather and analyze
your data, note investigation findings, and recommend actions to prevent such incidents. You can create multiple
investigations.

24



Global Human Resources Cloud
Using Workforce Health and Safety Incidents

Chapter 4
Manage Safety Incidents

1. In the Investigations page of the incident, click Add to create an investigation.
2. Specify these details in the Investigation Details region:

a. Date and Time
b. Summary and Description
c. Investigation Type and Incident Event
d. Lessons Learned
e. Click Save and Close. The investigation is created and appears in the Investigations page of the incident

3. In the Investigation Questionnaire region, you can add the investigation questionnaire to answer questions
related to the incident. Click Edit.

a. Search for and select Questionnaire Name. The questions appear in the region. You may want to answer
the questions now or later too.

b. Click Save.
4. In the Findings region, click Add to create findings.

a. Enter the Finding Summary details and Notes.
b. Select the Level of Security and specify Finding Response.
c. Optionally, you can create recommendations for every finding. Click Add Recommendation link and

specify your recommendation.
d. Click OK to save the finding. The finding is created and listed in the page.

5. In the Overall Findings region, you can specify the Casual Factors, Immediate Cause, Underlying Factors,
Root Cause, Contributing Factors, Comments, and Final Response and then click Save.

6. You can track your Notes for the investigation. Click Add.

a. Specify notes for the investigation.
b. Click Save. The note is saved and is displayed in the Notes region with name of the person who created

the note and the date when it was created.
7. In the Stakeholder region, click Add.

a. Specify the Name, person Type, and Category of the stakeholders.
b. Click OK.

8. Optionally, you can assign incident investigation Preapprovers, Approvers, Reviewers, and Owner and specify
the related details. In the Investigation Owner region, you can set a Target Completion Date. You can track
completion details when done with the investigation.

The application generates a unique identifier for the investigation and is displayed in the list under the
Investigations page. You can add one or more investigations for an incident.

Create Incident Actions  
Create one or more actions to find the cause of the incident, discover near misses, or rectify any unsafe conditions.

1. On the Actions page, click Add.
2. On the Action Details page:
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a. Enter Summary and Description.
b. Date and Time defaults to when the action was created. Modify it, if required.
c. Select Action Type from the list.
d. Select Resources Required.
e. Set the Action Priority from the list.
f. Specify the Estimated Cost and Currency.

g. Click Save.
3. Track notes for the Action in the Notes region. Click Add.

a. Specify notes for the event.
b. Click Save. The note is saved and is displayed in the Notes region with name of the person who created

the note and the date when it was created.
4. Assign incident action stakeholders, reviewers, preapprovers, and approvers in the respective regions of the

incident page and specify related details. Assign an incident owner and update the target completion date.
Specify the incident action Owners and the Target Completion Dates.

5. Select the action priority.
6. Select a safety coordinator for the incident if required.
7. Click Save.

When the action is complete, you can update the status and mark it complete.

The application generates a unique identifier for the Action and is displayed in the list on the Actions page. You can add
one or more Actions for an incident.

Add Attachments to Incident  
You can add attachments related to the incident such as photos or documents to help with the incident report.

1. On the Attachments page, click Add to add attachment or links.
2. For files, you can drag and drop the files or click Add File to specify the file path.
3. For links, click Add Link and specify the URL and click Save and Close.

The file name including the size and the person name who posted the attachment is listed in the Attachments
window. You can download the attachments or delete them.

4. Click Save. The files and links are listed in the Attachments page.

How You Close Incidents  
Here are a few things to keep in mind when you're closing an incident. Find the incident you want to close and check the
status in the Safety Incidents dashboard. Remember you can close an incident even if it has open actions.

To close an incident, everyone involved in the incident must select the completed check box on these pages.
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Pages Roles

Incident Events
 

Incident Event Owners
 

Investigations
 

Incident Investigation Reviewers, Incident Investigation Approvers, Incident Investigation Owners
 

Incident Details
 

Incident Reviewers, Incident Approvers, Incident Owners
 

Related Topics
• How can I close an incident action?

• How can I close an incident event?

• How can I reopen an incident?

• How can I delete an incident?

FAQs for Managing Safety Incidents  

Why can't I link a related incident?  
You may not have an assigned role in the related incident. You can link an incident only if you have an assigned role in
the related incident, such as the incident owner or reviewer.

How can I close an incident event?  
All incident event owners must select the Completed check box on the Incident Events page. You and the other incident
event owners can view this in read-only mode after closing the incident event.

How can I close an incident action?  
You must select Completed, Reviewed, or Approved in the Actions page of incident details, depending on what's
applicable to you as an incident action owner, reviewer, or approver. Keep in mind that only an incident owner can
reopen a closed action.
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How can I delete an incident?  
Only an Environmental Health and Safety Manager can delete an incident. To delete an incident, log in to the Safety
Incident work area, search for the incident you want to delete, and click the Delete icon.

How can I reopen an incident?  
Only an Environmental Health and Safety Manager can reopen a closed incident. On the Incident Details page, Incident
Sign Off section make sure that the Completed check box is unchecked.
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5  Analytics and Reports

Create Reports and Analytics  
Use the Oracle Business Intelligence Publisher to author, generate, and deliver reports and analysis for Workforce Health
and Safety Incidents. You must have the FBI_ENVIRONMENT_HEALTH_AND_SAFETY_TRANSACTION_ANALYSIS_DUTY
role to do this task. The EHS Manager already has the privileges assigned, so you can get started.

1. Click Navigator > Tools > Reports and Analytics.
2. On the Reports and Analytics page, click Create > Report.
3. In the Create Report dialog box, select the Use Subject Area box, and then select Environment Health and

Safety - Incidents Real Time from the Subject Areas drop down.
4. Click Next.
5. On the Select Columns page, click the expand icon in the Subject Areas drop down.
6. Click Continue.
7. Select the columns to include in the report and click Add.
8. Click Next.
9. On the Select Views page, enter a title to display for the analysis.

10. Select the type of table or graph to include. In the Layout option, specify the layout of the views, and click Next.
11. On the Edit Table page, you can specify more options for the table and click Next.
12. On the Edit Graph page, you can specify more options for the graph and click Next.
13. On the Sort and Filter page, you can add sorts or filters based on any of the columns you included. Click Next.
14. On the Highlights page, if you have a table, you can define conditional formatting for select columns. Click

Next.
15. On the Save page, enter the name of your analysis and select a folder to save it in.
16. Click Submit.

For more information about reports and analysis, see the Human Capital Management Cloud Creating and
Administering Analytics and Reports guide.
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